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Architectonisch ontwerp 

Vernieuwde balk- en kolom-gereedschap 

In ARCHICAD 23 wordt een grote sprong voorwaarts gemaakt in de ontwerp vrijheid van balken en kolommen. Zowel op gebied 
van design- als documentatie-workflow zijn er diverse verbeteringen. De balk- en kolom-gereedschappen zijn geheel vernieuwd 
en liggen in lijn met de andere vernieuwde gereedschappen. Daarnaast biedt de vernieuwde opzet uitgebreide mogelijkheden 
op gebied van 2D documentatie en informatiebeheer. 

  
Balken en kolommen bestaan nu uit een hiërarchische structuur waarbij het element bestaat uit één of meerdere segmenten die 
aan elkaar gekoppeld worden vanuit de aslijn. Deze segmenten kunnen elke vorm aannemen van rechthoekig, gebogen tot een 
eigen profiel. Ingewikkelde vormgeving, bijvoorbeeld een tand-oplegging, is met deze nieuwe functie snel gemaakt. 

Noot: 
Bij projecten die vanuit ARCHICAD 16 of ouder gemigreerd worden, wordt standaard de 'Legacy Intersection Mode’ 
aangezet, zodat de aansluitingen op de oorspronkelijke manier gehandhaafd blijven. Om de nieuwe functionaliteiten te 
kunnen gebruiken, moet deze uitgeschakeld worden:. Ga naar Options > Project Preferences > Legacy en zet het 
selectievak bij ‘Use Legacy Intersection Methods’ uit. Loop daarna de oude verbindingen na op correctheid. 

Vernieuwingen in het modelleren van balken en kolommen. 
De wijze waarop balken en kolommen gemodelleerd kunnen worden is vernieuwd en uitgebreid. Dit zorgt voor meer flexibiliteit 
en een betere workflow. 

Hellende balk of schuine kolom plaatsen middels twee klikken 
In 3D kan een balk of kolom met een helling, bijvoorbeeld een gording, met twee klikken geplaatst worden in elke richting, ook in 
de z-richting.  

     
Om de helling in het 3D venster zelf te bepalen op basis van de geklikte punten, moet de helling van de balk 
ingesteld zijn op ’horizontaal' (1). Voor kolommen is de instelling 'verticaal' (3) nodig in combinatie met de 
geometriemethode ‘Two Clicks’ (4). Voor een balk of kolom met een vastgestelde helling kan gebruik 
gemaakt worden van keuze ‘slanted’(2/5).  

Voor kolommen kan de helling op bovenstaande wijze ook in 2D vrij bepaald worden, hierbij wordt wel 
uitgegaan van een vooraf ingestelde hoogte.  

Kijk voor meer informatie over het plaatsen van hellende balken of schuine kolommen hier: https://
youtu.be/-cIUejXxjzY?list=PLnXY6vLUwlWX7I5g7dNfHUGFZa-OoUR3d&t=17 

Consistente geometriemethode tussen balken en kolommen. 
Balken ondersteunen nu ook een ronde vorm in de geometrie-methode net als het kolom-gereedschap. 

 

Vernieuwde manier om kolommen grafisch te wijzigen 
Vernieuwde selectie mogelijkheid bij kolommen op de plattegronden om elementen beter te 
selecteren en positioneren.  
 
Kolombreedten zijn nu aanpasbaar via het Petpalet. Klik hierbij op de punt of de rand en kies 
de gewenste bewerking in het Petpalet. De handelingen die nodig zijn bij het wijzigen van 
kolommen in de plattegrond zijn nu consistent met andere vernieuwde gereedschappen. 

1 2
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Verbeterde opties van de referentielijn 
• Het is nu mogelijk om zowel de rechthoekige als de (nieuwe) ronde profielen te roteren rondom de referentielijn. Dit was 

in eerdere versies alleen mogelijk met de geprofileerde balken. 
• Wanneer de positie van het ankerpunt wordt gewijzigd zal de locatie van de referentielijn en daarmee ook de geometrie 

van de balk of kolom verspringen. Dit is nu gelijk met de werking van wanden en vloeren ten opzichte van hun 
referentielijn of referentievlak. 

• Een balk heeft nu 9 ankerpunten, zoals bij kolommen.  
• De referentielijn van balken en kolommen is nu zichtbaar in gevels en doorsneden. 

Aansluitingen en eindpunten 
• De eindvlakken van balken en kolommen kunnen in elke hoek ingesteld kunnen worden: verticaal, horizontaal of in een 

zelf ingestelde hoek. 
• Ook de aansluiting tussen segmenten van een balk of kolom kan ingesteld worden op een gewenste hoek. 
• Aansluitingen en eindpunten kunnen grafisch aangepast worden in 3D of in gevels/doorsneden. 

   
Afgeschuinde einden           Grafisch aanpassen van een schuine segmentatie 

Verticaal gekromde balken 
Balken kunnen nu ook in de verticale richting gebogen worden (denk bijvoorbeeld aan het element voorzien van een zeeg of 
gelamineerde spanten in een sporthal). Dit kan ingesteld worden via de instellingen of grafisch via het Petpalet in 3D en in 
gevels of doorsneden. Hierbij is het ook mogelijk een helling op te nemen, waarbij het start- en eindpunt op een andere hoogte  
geplaatst kunnen worden. Een kromming geldt voor de gehele balk. Een los segment kan geen kromming mee krijgen. 

Let op! 
Een verticale kromming kan niet opgenomen worden in een balk met taps toelopende profilering of een gebogen balk. 

Sparingen in balken 
Benodigde sparingen kunnen met het nieuwe opening-gereedschap aangebracht worden in de balk. 

Let op! 
Openingen in kolommen zijn niet ondersteund, omdat dit vanwege constructieve redenen niet aan de orde is. 

Vaste of flexibele lengte segmenten 
Het is mogelijk om aan te geven welk segment van de balk of kolom een vaste hoogte of lengte heeft en welk gedeelte flexibel is 
bij het aanpassen van de afmetingen. In het geval van meerdere segmenten is het mogelijk om aan te geven hoeveel het 
percentage is ten opzichte van de gehele lengte.

  

Voorbeeld: 
Een gesegmenteerde kolom met oplegnokken. Hierbij is het van belang dat de nokken op de juiste hoogte blijven als de 
verdiepingshoogte aangepast wordt. Het onderste gedeelte van de kolom kan dan als het flexibele deel worden 
ingesteld. 
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Overnemen van instellingen in segmenten 
In de balk- en kolominstellingen kunnen via het rechtermuisknopmenu op een segment instellingen zoals grootte, structuur en 
eigenschappen gekopiëerd en geplakt worden naar andere segmenten. 

 
In de Edit Mode (zie verder in dit hoofdstuk) is het ook mogelijk om instellingen van andere segmenten over te nemen via het 
pipetteren en injecteren van de instellingen. 
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Modelleren op segmentniveau  
De nieuwe, gesegmenteerde logica verzamelt diverse sub-elementen met (potentieel) verschillende materialen en vormen langs 
de balk- en kolomreferentielijn. Dit zorgt voor een uitgebreidere vormvrijheid voor BIM elementen, zoals gewapend beton, staal, 
hout en samengestelde balken en kolommen. 

   
Doordat segmenten kunnen refereren aan parametrische profielen, kunnen ze gebruik maken van de voordelen van attributen: 

• Het centraal aanpassen van de geometrie bij gebruik van Complex Profiles 
• Datamanagement van Building Materials 
• Bij parametrische profielen is het mogelijk om grafisch individuele segmenten aan te passen, maar ook op eindstukken, 

bij taps-toelopende segmenten. 
 
Deze intuïtieve interacties zijn alleen mogelijk bij balk en kolom segmenten in alle 2D en 3D vensters, om zo efficiënt en correct 
mogelijk te modelleren. 

Voor segmenten zijn onderstaande nieuwe modelleermogelijkheden beschikbaar. 

Segmenten definiëren 
Balk- en kolomsegmenten kunnen gemaakt worden via de Settings dialoog en grafisch in het 3D venster, plattegrond/grondplan, 
doorsnede of gevel). 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Taps toelopende segmenten 
Deze nieuwe functie laat toe om te variëren met breedte en hoogte parameters bij het start- en eindstuk. Dit is mogelijk bij 
rechthoekige, cirkelvormige en geprofileerde segmenten.

 
Bij Complex Profile segmenten is het resultaat van de taps toelopende extrusie afhankelijk van hoe de Complex Profile Modifiers 
ingesteld zijn bij dit taps toelopend segment. Door het gebruik van Modifiers kunnen vanuit eenzelfde Complex Profile meerdere 
parametrische variaties gegenereerd worden, waardoor er een grotere diversiteit van segment-vormen kan ontstaan. 
Kolomafwerking is ook toepasbaar op taps toelopende vierkanten en cirkelvormige segmenten. 

Let op! 
Taps toelopende segmenten zijn niet toepasbaar bij verticaal gebogen balken. 

Edit Mode bij segmenten 
De Edit Mode bij balken en kolommen zorgt voor een passende en effectieve grafische aanpassingsmethode voor deze 
segmenten: Offset Edge van Complex Profile segmenten, verplaatsen van segment aansluitpunten en het oprekken van 
segmenten. 
 
Gebruik de Edit Mode om de geometrie of taps toelopende segmenten aan te passen, dit kan zowel grafisch als numeriek. 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Nieuwe Interface voor instellingen 
De vensters voor de Settings en Info Box voor het balk- en kolom-gereedschap zijn aangepast aan de nieuwe mogelijkheden. 

Uitgebreider instellingsvenster  
• De nieuwe boomstructuur maakt een opsplitsing naar logische onderdelen, inclusief aparte delen voor segmenten en 

plattegrond/grondplan weergave.  

• Pas segmenten per onderdeel aan in de nieuwe Edit modus en met behulp van segment-specifieke instellingsvenster.  

• Het nieuwe dialoogvenster is qua inhoud afgestemd op de  andere hiërarchische gereedschappen in ARCHICAD, zoals 
vliesgevel, trappen en relingen.  

• Een preview venster toont het resultaat.  

Sub-element/element-niveau data-management 
Vanaf ARCHICAD 23 is het mogelijk om ARCHICAD Properties en parameters van balken en kolommen te gebruiken bij het label-
gereedschap en in de Interactive Schedules op zowel segment- als elementniveau. 

  
Onderstaand de belangrijkste functionaliteiten en wijzigingen hierin:  
• Ingebouwde en eigen ARCHICAD Properties en classificaties kunnen toegekend worden aan balk- en kolom-elementen, net 

als in vorige ARCHICAD versies, en aan de segmenten. 
• De eigenschappen ‘dragend/niet-dragend (loadbearing /non-loadbering) en positie (interior / exterior) worden bepaald op 

element-niveau. 
• Het opnemen in Schedules en het labelen van elementen blijft ongewijzigd en werkt daarbij ook voor de segmenten 
• Favorieten van balken en kolommen kunnen met een vaste lengte opgeslagen worden..  
• De Graphic Override en de renovatiefilters werken zoals bij het trap- en vliesgevel-gereedschap 
• Het autotekst-label ondersteund ook de segmenten van balken en kolommen . 

Volledige 2D documentatie 
Op gebied van 2D weergave zijn de mogelijkheden uitgebreid om beter te kunnen voldoen aan de gestelde eisen voor 
documentatie. 
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Cover Fill voor balken en kolommen 
Balken en kolommen hebben nu een Cover Fill (dekkende arcering) consistent met andere modelleergereedschappen in 
ARCHICAD. Elk type arcering (ingesteld als Cover Fill) kan worden gekozen, waarbij de richting of schaal van de arcering 
aangepast kan worden. 

Voorbeeld: 
Een balk kan nu beter gebruikt worden als vensterbank, goot of als wandafdekking.  

  

Let op! 
De Cover Fill van balken is alleen zichtbaar, wanneer balken op een hoogte zijn gemodelleerd die onder het horizontale 
snijvlak (Floorplan Cut Plane) valt! Om deze Cover Fill zichtbaar te tonen, terwijl de balk boven het snijvlak ligt, kan de 
Floor Plan Display worden ingesteld op: Outlines Only. Of de hoogte van het Floorplan Cut Plane worden aangepast en 
opgeslagen in de View Settings. 

Aanpasbare 2D weergave (Hybride Floor Plan) voor balken 
De balken krijgen, in navolging van het vliesgevel-gereedschap, een nieuwe vorm van weergeven, de ‘Hybrid Floor Plan 
Projection'. Als aanvulling op instelmogelijkheden voor een symbolische of geprojecteerde weergave kan er nu per onderdeel 
gekozen worden. Aparte instellingen zijn mogelijk voor de Cut, Uncut en Overhead weergave van een balk. 

 
De standaardinstelling is ‘Projecten with overhead’ hiermee worden balken correct worden weergeven ten opzichte van hun 
hoogteniveau. 

 

© KUBUS 12-11-2019  van  Handleiding ARCHICAD 238 36



2D weergave van balken onder een vloer of andere balk 
Een speciale 2D weergave is nu beschikbaar voor balken. Op het moment dat een balk wordt overlapt door een vloer of een 
andere balk dan wordt de 2D weergave hierop aangepast. Een deel van de balk zal een gesloten lijn hebben en het verborgen 
deel wordt door een stippellijn weergegeven. Deze functie kan aangezet worden in de MVOC (Document> Model View > Model 
View Options… Construction Element Options > Beam). 

    

Tip: 
Indien de balk niet in stippellijn wordt weergegeven kan de balk via Rechtermuisknopmenu > Display Order> Bring To 
Front naar voren gehaald worden. Hierbij hoeft geen rekening gehouden te worden met de volgorde van elementen.  

Nieuwe opties voor 2D weergave op verdiepingen (Show on Stories) 
Het is nu mogelijk om als 2D weergave van balken en kolommen te kiezen voor boven en onder de huidige verdieping (‘One 
Story Up’ of ‘One Story Down’). Deze instelling is te vinden onder Settings > Floor Plan and Section > Floor Plan Display > Show 
on Stories. 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Opening-gereedschap 

Met ARCHICAD 23 wordt het opening-gereedschap geïntroduceerd, dat is ontwikkeld voor het modelleren, het beheren van 
‘opening-informatie’ en het de documenteren van openingen. Gebruik het gereedschap voor het creëren van gaten, sparingen 
en nissen door een willekeurige aantal elementen. 

      
Openingen zijn onmisbare BIM elementen, zowel voor de architect, de constructeur/ingenieur stabiliteit en de installatie-
adviseur/ingenieur technieken. Sterker nog; openingen in dragende constructies is de meest uitgewisselde informatie tussen 
deze disciplines. 

ARCHICAD 23 biedt een stevig kader voor het het beheren van intelligente openingen met hun geometrische parameters en 
aanvullende ARCHICAD Properties. Met de zogenaamde ‘Provision for Voids’ werkmethodiek kunnen de ontwerpende disciplines 
eenvoudig hun BIM Opening databases synchroniseren. ARCHICAD 23 gebruikt een nieuwe-generatie technologie om de 
symbolische 2D-weergave van de constructieve elementen en hun openingen zo weer te geven dat dit is afgestemd op de 
algemeen geldende teken standaarden.  

Technische versus architectonische openingen 
Een typisch BIM-model bevat twee type openingen: technische en architectonische. 

• Technische openingen 
Dit zijn openingen die worden gemaakt in constructies om ruimte te maken voor systeemcomponenten (bijvoorbeeld 
leidingen en pijpen). Deze openingen worden in het algemeen gespecificeerd en geplaatst door de installatie-adviseur/
ingenieur technieken, maar moeten worden goedgekeurd door de architect en/of constructeur/ingenieur stabiliteit. Met 
het opening-gereedschap kan een ARCHICAD modelleur deze technische openingen plaatsen in een BIM-model. 

• Architectonische openingen 
Deze openingen bevatten vaak een raam of een deur, of het zijn lege openingen, nissen en uitsparingen. Deze openingen 
worden doorgaans door de architect bepaald en geplaatst, maar moeten worden goedgekeurd door de constructeur/
ingenieur stabiliteit. 

Noot: 
Bij projecten die vanuit ARCHICAD 16 of ouder gemigreerd worden, wordt standaard de 'Legacy Intersection Mode’ 
aangezet, zodat de aansluitingen op de oorspronkelijke manier gehandhaafd blijven. Om de nieuwe functionaliteiten te 
kunnen gebruiken, moet deze uitgeschakeld worden:. Ga naar Options > Project Preferences > Legacy en zet het 
selectievak bij ‘Use Legacy Intersection Methods’ uit. Loop daarna de oude verbindingen na op correctheid. 

Modelleren van technische openingen 
In ARCHICAD wordt de vorm van een opening gedefinieerd door het zogenaamde ‘openingslichaam’ (vanaf nu ’Opening Body’ 
genoemd) en de gekoppeld(e) element(en). Elke opening is verbonden met minimaal één element, maar kan ook verbonden 
worden met meerdere elementen. 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Opening Body 
Het openingslichaam is een lineaire extrusie van een polygoon met een rechthoekige, cirkel of elliptische vorm. De vorm 
(hoogte/breedte) kan aangepast worden in het Instellingen venster > Geometry and Positioning. 

 
Openingsvormen - Extrusie begrenzingen 

Nissen en uitsparingen kunnen als volgt ingesteld worden: 
• Wijzig het bereik van de openingen (standaard ’oneindig’ (infinite)) naar ‘eindig in 1 richting’ (semi-infinite) of ‘eindig in beide 

richtingen’ (finite) 
• Bepaal de diepte van de nis of uitsparing t.o.v. het referentievlak van het ‘gastelement’ door de lengte van de Opening Body 

en eventueel een offset in te geven 
• Gebruik het commando ‘Flip’ (F) om de nis of uitsparing te spiegelen om het referentievlak 
• Bepaal de exacte lengte van de extrusie bij de ‘finite’ optie. Hiermee kunnen openingen gemaakt worden die (bijna) geheel 

binnen het ‘host’-element liggen 

Gekoppelde elementen 
In ARCHICAD 23 kunnen openingen worden aangebracht in wanden, vloeren, balken en Meshes. Een opening kan gekoppeld 
worden aan een of meerdere elementen en hier ook gaten doorheen maken. De opening is echter slechts aan één element echt 
verbonden: het zogenaamde host-element. 

   

De koppelingen kunnen aangepast worden via de ‘Openings Grips’: 
• Nieuwe te doorsnijden elementen toevoegen/koppelen aan de Opening Body: klik het gewenste element aan 
• Koppelingen verwijderen: klik op het kruisje 
• Het hostelement wijzigen: beweeg over het nieuwe hostelement en klik op de punaise 
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Positionering en oriëntatie 
De positie van een opening wordt bepaald in relatie tot het hostelement en verplaatst ook met het hostelement mee. Wordt een 
element verplaatst dat wel gekoppeld is aan de Opening Body, maar niet het hostelement is dan zal de opening blijven staan op 
de originele positie. In onderstaand voorbeeld is de opening gerelateerd aan de betonnen wand (host-element) en is de isolatie 
alleen maar gekoppeld aan de opening.  

 
De richting van de opening kan gedefinieerd worden als horizontaal, verticaal of uitgelijnd zijn (perpendicular to) op het vlak van 
het hostelement. 

  

Daarnaast kan een eigen hoek ingesteld worden: 
• Selecteer een geplaatste opening 
• Kies in de infobox of het instellingen venster bij ‘orienation’ voor ‘Custom Orientation’ 

 
• Draai de opening naar de gewenste positie  

© KUBUS 12-11-2019  van  Handleiding ARCHICAD 2312 36



Ankerpunt 
Een opening heeft negen mogelijke ankerpunten (vergelijkbaar met kolommen en balken). Het ankerpunt wordt gebruikt om de 
hoogte/niveau van de opening te meten. Als de Opening Body horizontaal of uitgelijnd (aligned) is kan de hoogte van het 
ankerpunt ingegeven worden gerelateerd aan de home story van het hostelement, bijvoorbeeld bij een opening in een wand. 

Tip: 
Bij het plaatsen in 3D kan in de Tracker een z-waarde worden ingevuld.  

Intuïtieve en consistente plaatsing en aanpassing 
De intuïtieve wijzigingsinteracties maken het makkelijk om met openingen te werken. De status van de openingen zijn tastbaar 
in alle 2D en 3D vensters en alle bekende bewerkingsopties zijn beschikbaar via het pet palette en het menu ‘Edit’.

 

Tip: 
De ‘Opening Body’ kan worden weergegeven via het menu View > On-Screen View Options > Opening Cutting Bodies. 
Voor alleen een subtiele weergave (hoekjes) op plattegrond is er de optie View > On-Screen View Options > Opening 
Reference Planes. 

Openingen kunnen in alle (ondersteunde) elementen, zoals balken, vloeren, wanden en Meshes op dezelfde manier geplaatst en 
aangepast worden: 

• Openingen kunnen alleen gekopieerd/ geplakt worden als het ook het hostelement gekopieerd/geplakt wordt 
• Een opening kopiëren, zonder het hostelement te kopiëren of te verplaatsten kan met het commando ‘Drag a Copy’ 
• Stretch, Offset en Rotate werken in alle beschikbare vensters 
• De Free Rotate functie is beschikbaar voor openingen (deze werkt zoals bij het Morph-gereedschap) 
• Het transfereren van parameters tussen openingen kan met d’e Pick-up and Inject’ Parameters functie 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Direct openingen maken met elementen en objecten 
ARCHICAD 23 biedt een werkmethodiek om direct openingen te maken ter plaatse van kruisende/overlappende 
modelelementen en objecten. 

     
Met een enkele klik worden openingen gemaakt in elk element dat een overlap heeft met de geselecteerde gebouwelelementen. 
De vorm en offset van de openingen kan worden gedefinieerd met de instellingen in het ‘Create Openings’ dialoog venster.  

1. Selecteer de operators (de elementen waarvoor een sparing/opening gemaakt moet worden 
2. Open via Design > Connect > Create Openings From Selection… het ‘Create Openings’ venster en stel dit in: 

• Kies de vorm van de opening 
• Stel eventueel een offset in voor extra ruimte rondom het operator element 
• Bepaal of het element (op basis waarvan de opening gemaakt wordt), behouden moet blijven of niet.  

In het geval van installatie objecten/ elementen zal dit over het algemeen zo zijn. 
• Kies of dicht bij elkaar gelegen openingen tot één opening gemaakt moeten worden. Bijvoorbeeld bij vloeren/

plafonds die dicht bij elkaar liggen. Stel in vanaf welke afstand openingen met elkaar ‘ge-merged’ worden. 

 

Let op! 
‘Mergen’ van openingen geldt alleen voor achter- of boven elkaar liggende elementen. 

• Bepaal of het ID van de nieuwe openingen overgenomen moet worden van het operator element of wordt ingesteld 
conform het ID in de opening tool settings. 
Het overnemen zal met name interessant zijn als bijvoorbeeld de openingen eerder op een andere manier zijn 
gemodelleerd of als men de code van het modelelement terug wil laten komen in de uiteindelijk code. 

Noot: 
Zijn de ‘kruisende’ elementen al van elkaar afgetrokken, bijvoorbeeld door de automatische verbindingen of SEO, dan 
zijn de elementen voor ARCHICAD niet meer overlappend en wordt er dus geen sparing gemaakt. Zorg in dat geval dat 
de lagen van de elementen een verschillend Layer Intersection Ggroup Number hebben. Dit zal het geval zijn bij o.a. 
wanden en balken. 

Modelleren van architectonische openingen 
ARCHICAD 23 ondersteunt werkmethodieken die openingen combineert met ramen- en deurobjecten en vliesgevel elementen. 

Ramen en deuren objecten kunnen in een opening in een enkele wand geplaatst worden. De breedte en hoogte van de objecten 
moet overeenkomen met de afmetingen van de opening. Alle raam- en deuraccessoires (wandaansluiting, dorpel, vensterbank 
enzovoort) moeten worden gedefinieerd in de raam- of deurinstellingen. Wees er van bewust dat het raam of de deur los staat 
van de opening. Als het raam of de deur in de wand wordt verplaatst, moet de opening daarna apart verplaatst worden.  
Het voordeel van deze workflow is dat het de gebruiker de mogelijkheid geeft om alleen de openingen (voorstel voor sparingen 
in een wand ten behoeve van een raam of deur (Provision for Void)) op te nemen in een overzichtslijst. Ook kunnen de 
openingen apart worden geëxporteerd naar een IFC model. 

In ARCHICAD 23 is het ook mogelijk om vliesgevels, ramen en deuren in een opening te plaatsen die met meerdere wanden 
gekoppeld is. Plaats hiervoor een opening in een muur als hostelement en koppel daarna de opening met de overige wanden. 
Plaats vervolgens een raam, deur of vliesgevel in de opening. 

Noot: 
Merk op dat de deur- en raamaccessoires niet kunnen worden gebruikt in deze workflow (bij openingen die zijn 
verbonden met meerdere muren). 
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Informatiebeheer en visualisatie van de nieuwe openingen 

Lijsten & Labels  
Geef een opening een label om de afmetingen (hoogte, straal, diameter, diepte, ankerhoogte, hoogste niveau), element-
classificaties en alle standaard- of aangepaste (IFC) eigenschappen weer te geven. Dit kan zowel als tekst/     autotekst met het 
Text / Autotext label of als samengestelde parameters met de Classificatie en Properties label. 
Openingen en de eigenschappen ervan kunnen ook in schedules worden getoond. 

 

Compatibiliteit met bestaande functies 
• In Teamwork kunnen openingen los van de elementen waarin deze geplaatst zijn gereserveerd worden. 
• Favorieten voor openingen kunnen van een selectie opgeslagen worden. 
• Openingen zijn compatibel met de renovatie-functie en Partial Structure Display (voorbeeld: de afmetingen veranderen 

afhankelijk ervan welke gekoppelde elementen zichtbaar zijn). 

Documentatie van de nieuwe openingen 
De standaard grafische vereisten voor het documenteren van sparingen zijn meestal vastomlijnd en kunnen van land tot land 
verschillen. In ARHICAD 23 is het mogelijk om de 2D symbolische weergave conform de nationale standaard weer te geven in de 
plattegrond-tekeningen. 

Noot: 
De symbolische weergave is niet beschikbaar voor doorsneden en gevels. 

Floor Plan Display 
• De 2D-weergave van een opening kan voor elk geplaatst element apart ingesteld worden bij Settings > Floor Plan and 

Section > Floor Plan Display 
• Verdeelde openingen kunnen als geheel of apart worden getoond  

 

Divided 

Outlines/ 
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• Slimme GDL objecten kunnen gebruikt worden om de gewenste plattegrond weergave te verkrijgen. In de KME zijn hiervoor 
enkele favorieten opgenomen. 

 

Weergave van Cut Surfaces, Outlines en Cover Fills 
De instellingen voor Cut Surfaces, Outlines en Cover Fills biedt de gebruiker 
aanvullende mogelijkheden voor het aanpassen van de weergave van de 
opening symbolen in 2D. Gebruik voor de Cut Surfaces, Outlines en de Cover 
Fills de eigenschappen van het doorsneden element of stel de eigenschappen 
naar wens in met de beschikbare parameter instellingen, zoals te zien in 
onderstaand voorbeeld.  

 

Samenwerken middels IFC en de nieuwe Opening Tool 
Een roundtrip met opening data is mogelijk tussen ARCHICAD 23 en engineering software van andere partijen. Een opening kan 
in IFC op twee manieren worden beschreven. Als een ‘IFC opening’ of als een ‘IFC Provision for Void’. Hieronder worden beide 
methoden toegelicht. 

IFC Openings 
Een IFC opening is altijd gekoppeld aan één element met een relationele link. Een IFC opening kan een raam of deur bevatten, 
maar dat hoeft niet. 

Importeren IFC Openings 
Een IFC opening kan in ARCHICAD 23 op drie verschillende manieren geïmporteerd worden, afhankelijk van de onderstaande 
condities: 

1. Door/Window subtyped GDL element 
(GDL Empty Opening Door/Window object) wordt gegenereerd als: 

• Het doelelement een wand is (in ARCHICAD kunnen alleen wanden GDL openingen bevatten), 

• De opening een extruded vorm heeft (dus geen vrije vorm BREP’s) en 

• Er een deur of raam binnen de opening aanwezig is. 

2. Nieuwe ARCHICAD opening 
Deze wordt gemaakt in geval: 

• Het doelelement een wand, vloer, balk of Mesh is, 

• De opening leeg is (bevat geen deur of raam) en 

• De opening een rechthoekige of ronde basisvorm (polygoon) heeft en een geëxtrudeerd lichaam heeft. 

3. Morph 
Op een verborgen laag (hidden layer) wordt een Morph geplaatst, welke gebruikt wordt als operator element in een 
Solid Element Opertation (SEO) als: 

• Het doelelement geen wand is, 

• Er geen ramen of deuren in de opening zitten en 

• De vorm van de opening één of meerdere BREP’s bevat. 

De Morph kan geclassificeerd worden als ’opening’ en opgesomd worden in dezelfde Schedules als de ARCHICAD 
openingen. 
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Exporteren IFC Openings 
Een ARCHICAD  opening kan vanuit ARCHICAD 23 op drie verschillende manieren geëxporteerd worden, afhankelijk van de 
onderstaande condities: 

1. ARCHICAD GDL Empty Opening Door/Window objects 
Worden geëxporteerd als IFC Opening 

2. Nieuwe ARCHICAD opening 
Wordt geëxporteerd als IFC Opening. 
Indien een Opening door meerdere elementen gaat dan zal de Opening in het host-element worden geëxporteerd als 
een ifcOpeningselemen, inclusief alle metadata. De openingen in de andere elementen worden in IFC weergegeven als 
gaten (gemaakt met Solid Element Substraction) 

3. Morph die een sparing representeert 
Kan worden geclassificeerd als IFC Type: Opening, maar kan niet worden geëxporteerd als een IFC Opening. 

IFC ‘Provision for Voids’ 
Een ‘Provision for Voids’ is een eenvoudig Building Element Proxy met een speciaal gekoppeld IFC Attribute (Provision for Void). 
Een ‘Provision for Voids’ kan geen raam of deur bevatten. 

Importeren ‘Provision for Voids’ 
Architecten ontvangen van een andere ontwerp-discipline een IFC model met ‘Provision for Voids’ erin. Dit model kan alleen 
‘Provision for Voids’ bevatten (voorkeur) of daarnaast ook andere elementen. 

   
De Morphs die een IFC ‘Provision for Void’ representeren worden ook zo geclassificeerd in ARCHICAD 23. Gebruik vervolgens 
‘Find and Select’ om ze snel te kunnen filteren van de andere Building Element Proxies die geïmporteerd zijn als Morph. 

Gebruik de functie ‘Create Openings from Building Elements’ (menu Design > Connect) om deze Morphs (representaties van de 
door de architect goedgekeurde ‘Provision for Voids’), eenvoudig om te zetten naar native ARCHICAD Openings 

Exporteren ‘Provision for Voids’ 
‘Provision for Voids’ die zijn gemodelleerd met Morphs en in ARCHICAD zijn geclassificeerd als ‘Provision for Voids’, worden 
daarna geëxporteerd als IFC ‘Provision for Voids’. 

Native ARCHICAD 23 openingen kunnen niet direct als IFC ‘Provision for Voids’ geëxporteerd worden. Deze elementen moeten 
eerst worden omgezet naar Morphs, vervolgens geclassificeerd worden als ‘Provision for Voids’ en kunnen daarna als IFC 
‘Provision for Voids’ geëxporteerd worden. 

© KUBUS 12-11-2019  van  Handleiding ARCHICAD 2317 36



2D Weergave van aansluitende vloeren op plattegrond/grondplan 

Bij twee of meerdere aansluitende vloeren kan gekozen worden hoe de aansluiting op plattegrond/
grondplan wordt weergegeven. 

Let op! 
Dit werkt alleen bij aansluitende vloeren met dezelfde afwerking aan de bovenzijde en waarbij de bovenkant 
van vloeren op hetzelfde niveau liggen. 

De aansluiting kan ingesteld worden via de Model View Options > Construction Element Options:

 

Er zijn de volgende opties: 
• Show Lines: de overlappende rand blijft zichtbaar (zoals in ARCHICAD 22 en eerder) 
• Eliminate: De overlappende rand wordt onzichtbaar 
• Use Hidden Lines: De overlappende rand wordt als streeplijn weergegeven 

De Hidden Lines zijn een instelling van het vloer-gereedschap 

 

 

Tip: 
Deze nieuwe feature biedt een oplossing om bij renovaties vloeropeningen te maken, zonder dat deze nog gevulde 
‘opening’ in de bestaande toestand zichtbaar zal zijn.
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Visualisatie 

Nieuwe CineRender Engine 

ARCHICAD 23 maakt gebruik van de nieuwe CineRender Engine (R20). De verbeterde progressieve physical renderer zorgt voor 
snellere en betere resultaten. 

Update Surface Catalog 

In ARCHICAD 23 is de ingebouwde Surface catalogus volledig vernieuwd met de volgende verbeteringen: 
• Echte reflecties en Parallax-offset, voor een verbeterd fotorealisme 
• Gemoderniseerde texturen voor hoge resolutie renderings 
• De nieuwe Surfaces gebruiken waar mogelijk vereenvoudigde, bijgewerkte parameters 

  

  

  
Verbeterde Surfaces: Before (AC22) and After (AC23) 
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Productiviteit 

Geïntegreerde softwaresleutel-activatie en -deactivatie 

In ARCHICAD 23 is het activeren en deactiveren van de softwarelicentie volledig geïntegreerd; de 
softwaresleutel kan automatisch geactiveerd (‘Download’) en handmatig gedeactiveerd (‘Upload’) worden, 
zonder gebruik te maken van de License Manager Tool 

• Automatische softwaresleutel-activatie (download) 
Als ARCHICAD tijdens het opstarten geen softwaresleutel kan vinden (op de computer of in het 
netwerk) EN de gebruiker is ingelogd met een geldig GRAPHISOFT ID (GSID), dan zal ARCHICAD 
automatisch een softwaresleutel downloaden vanuit de License Pool zodat er direct met ARCHICAD 
gewerkt kan worden. 

• Handmatige Software sleutel deactivatie (upload): 
De softwaresleutel kan eenvoudig geüpload worden naar de License pool.  Dit kan rechtstreeks vanuit 
het Help menu in ARCHICAD, waardoor het overbodig is om de License Manager Tool op te starten. 

Hernoemde filters blijven gelinkt aan View Settings 

Als in voorgaande versie van ARCHICAD de filters voor Layer Combinations, Model View Options, Pen Sets, 
Renovatiefilters, Graphic Override Combinations, Dimensions en 3D Styles werden hernoemd, werden deze ‘missing’ bij de Views 
die gebruik maakten van deze filter(s). De oorzaak hiervan was dat link gebaseerd was op de naam van deze filters. 

Vanaf ARCHICAD 23 wordt er gebruik gemaakt van een unieke identificatie voor de filters, zodat deze filters na het hernoemen 
zichtbaar worden met de nieuwe naam. 

Meer mogelijkheden aanwijslijn Label Tekst /Autotekst  

De positie van de aanwijslijn van het label ‘Tekst/Autotekst’ kan specifieker geplaatst worden: 
• Connectie met de box, of aan de bovenste of onderste tekstregel (1) 
• Connectie met de bovenkant, het midden of de onderkant van de tekstbox (2) 
• Verlengde aanwijslijn zodat tekst onderstreept kan worden (3) 

 

Kleine verbeteringen 

Een aantal kleine maar handige verbeteringen en correcties. 

Publisher Palet 
Mogelijkheid om het geëxporteerde bestand te lokaliseren in de Verkenner of Finder door op het bestand het 
rechtermuisknopmenu op te roepen en te kiezen voor ‘Show in File Explorer/Finder’. 

 

1 2 3

1 2 3
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Interactive Schedules - zoomfactor  
Zoomfactor aangepast naar 25% (was 20%) en nieuwe zoomfactoren van 75% en 125% toegevoegd.  

 

Interactive Schedules - Header en rebuild 
De Header is opgeschoond en vereenvoudigd, om meer ruimte aan de inhoud te geven. 
In het Settings Menu (1) is een ‘Rebuild’ mogelijkheid toegevoegd om de Schedule sneller opnieuw te kunnen genereren. 
 

 

 

Edit Selection Set dialoogvenster 
Het ‘Edit Selection Set’ venster kan nu ook in breedte opgerekt worden, zodat de inhoud beter zichtbaar gemaakt kan worden. 

Bepalen van criteria 
Bij het bepalen van criteria (zoals bij Find&Select) is de pop-up lijst beter gestructureerd zodat de benodigde items 
gemakkelijker gevonden kunnen worden. 

 

Vanaf ARCHICAD 23

1

Vorige ARCHICAD versies

Vorige versiesAC23
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Programmakop (alleen Windows) 
De ARCHICAD Header is vereenvoudigd. Waarbij overbodige informatie (zoals ‘GRAPHISOFT’ naam) is achterwege is gelaten. 

 

Complex Profiles - nieuwe Modifier 
Bij het toevoegen van een nieuwe Modifier, is het nu mogelijk om direct op te slaan vanuit het waarschuwingsmenu. 

Het aanpassen van de Reling geometrie 
• Er zijn twee nieuwe Pet Palet commando’s beschikbaar om de Reling Reference Line te offsetten, waarbij er een keuze is 

tussen één bepaald segment of alle segmenten van de Reference Line. 

 
• In de Edit modus is er ook de mogelijkheid om één bepaald segment of alle reling segmenten te offsetten waarbij de 

Reference Line zijn positie behoudt. 

 

Lijst van Complex Profiles (alleen Windows) 
Probleem op Windows opgelost waarbij de Profielnaam werd afgebroken. (Op MAC werkte dit al goed). 

Complex Profiles - randlijn 
De randlijnen tussen twee aangrenzende arceringen met verschillende breedten wordt nu altijd gewoon, waar deze voorheen 
soms verdween. 

 
Nieuwe IFS-functie bij Expressies 
Deze IFS-functie kan gebruikt worden om een reeks van logische condities te testen, waarbij deze functie stopt bij de eerste 
conditie waarbij het resultaat ‘True’ is. IFS is een handige methode om geneste IF-functies te vermijden (wat vaak omslachtig 
wordt ervaren). 

Zonlicht-instellingen 
Tijdens het verslepen van de schuifbalk in het menu View > 3D View Options > 3D Projections Settings > Sunlight, wordt er live 
feedback weergegeven. 

Vorige versiesAC23

© KUBUS 12-11-2019  van  Handleiding ARCHICAD 2322 36



Info Box update 
Voor het Zone- en Label-gereedschap zijn delen van de Info Box geüpdatet: Geometry Method en Construction Method worden 
volledig weergeven in plaats van via een pop-up. 

    
Label Tool ARCHICAD 23     Zone Tool ARCHICAD 23 

Shell en Morph input 
Dialoogvenster voor de invoer zijn vereenvoudigd en verder verduidelijkt met behulp van iconen.

   
Voorbeeld Morph ARCHICAD 23     ARCHICAD 22 

Composiet Menu 
‘Duplicate’ functie is opgenomen in de ‘New’ knop. Dit is nu gelijk met de andere attributen. 

Attribute Manager - zoekveld 
Het zoekveld wordt verlengd als het menu opgerekt wordt. 

Attribute Manager - missing Textures 
Wanneer Surfaces een textuur missen worden deze onderdelen aangeduid met een rood-ingekleurd icoon.

  
Het is mogelijk om te sorteren op de missende texturen, door op de kolomkop te klikken. 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Attribute Manager 
Bij het overzetten van Layer Combinations, is er een mogelijkheid om ook Layers mee om te zetten. Vink hiervoor “Include All 
Associated Layers” aan. (Deze checkbox bestond al in pre-22 ARCHICAD versies en is nu weer beschikbaar in ARCHICAD 23 
dankzij de de vele verzoeken van de gebruikers).

 

Zonstudie 
Bij het opslaan naar videoformaat, is het nu mogelijk datum en/of tijd op te slaan. Via knop ‘Edit…' kan de inhoud, positie en 
opmaak van de datum/tijdstempels ingesteld worden.  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Work Environment 
Nieuwe zoekfunctie beschikbaar bij de onderdelen voor sneltoetsen, Toolbars en Menu-items. 

 

AFP Connecties als SMB Connecties toepassen (alleen Mac) 
Vink deze optie aan om zeker te zijn dat ARCHICAD het SMB-file-server-protocol gebruikt (en niet AFP) als er externe bestanden 
gelinkt zijn (zoals Drawings). Beide protocollen kunnen nog gebruikt worden, maar het aanvinken zorgt dat het SMB-protocol 
gebruikt wordt. (MacOS 10.14 ondersteunt het APFS bestandssysteem, die het SMB protocol gebruikt en niet het AFP protocol). 
Deze Optie kan teruggevonden worden in het Options Menu > Work Environment > Network and Update…

 

Verbetering bij Delete and Replace 
Als er items met missende attributen zijn, kan er een gedetailleerd overzicht opgeroepen worden in de internetbrowser waarbij 
alle items één per één getoond worden volgens naam, ID, locatie.  
Kies in het betreffende attribuutvenster voor Delete… > Details… > ‘Show Details in Browser…’ 
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ARCHICAD bestanden openen 
Wanneer het ARCHICAD dialoog venster wordt gebruikt om ARCHICAD bestanden (PLN or PLA) te zoeken en te openen, dan 
zijn de backup (BPN) bestanden niet meer beschikbaar bij de keuze in ‘All ARCHICAD Projects’. Dit bestandstype is uitgegrijsd. 
Dit zorgt ervoor dat er niet meer per ongeluk een ouder Backup bestand geopend wordt.

  

Uiteraard kunnen de Backup-bestanden eenvoudig geopend worden door het bestandstype in te stellen op ‘All Files’.

 
 Of open het bestand vanuit de Finder of Verkenner door te dubbelklikken. (Let dan goed op de gebruikte ARCHICAD versie) 

© KUBUS 12-11-2019  van  Handleiding ARCHICAD 2326 36



Prestaties 

Nieuw opstartvenster - meerdere projecten tegelijk openen 

ARCHICAD gebruikers werken dagelijks aan meerdere projecten tegelijk. Het nieuwe opstartvenster geeft een overzicht van 
recente projecten (in lijstvorm of met previews) en biedt de gebruiker de mogelijkheid om meerdere projecten in het overzicht 
te selecteren. Met één handeling worden deze projecten vervolgens geopend in meerdere ARCHICAD sessies. 
 

 
 

 

Daarnaast kunnen projecten uit de lijst verwijderd worden met het blauwe kruisje, het project zelf blijft gewoon bestaand. 

Let op! 
De optie ‘Migrate Library when necessary’ bij voorkeur niet gebruiken: zet het vinkje uit. 
Voor de KME werkt deze zeker niet goed en bij gebruik van de standaard bibliotheek worden vaak ook te veel subset-
bibliotheken geladen. Lees T&T 001 over het migreren van projecten en T&T 003 over de migratie van bibliotheken. 
Deze zijn hier te vinden: https://www.kubusinfo.nl/Support/ArchiCAD/tips-en-trucs#Upgraden  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Open een project, zonder verdere vragen  

ARCHICAD controleert bij het openen van bestanden automatisch diverse aspecten, zoals ‘Drawing updates’, het kunnen laden 
van bibliotheken en de status van Hotlinked Modules. In ARCHICAD 23 worden deze checks nog steeds uitgevoerd, maar nu 
zonder het proces te verstoren. Na het ‘openingsproces’ wordt middels het nieuwe ‘Action Center’ een overzicht getoond welke 
acties ARCHICAD kan uitvoeren. Het Action Center wordt zichtbaar als Tabblad in het actieve venster. De gebruiker kiest welke 
acties aandacht verdienen of kiest ervoor direct aan het werk te gaan. Via het menu File > Info > Action Center kan het overzicht 
later altijd nog opgeroepen worden om de actiepunten te controleren en te beheren.

 

Open een project sneller 
Met ARCHICAD 23 is het proces voor het openen van bestanden verder geoptimaliseerd. Alle optionele processen worden 
uitgesteld naar een latere fase, totdat het bestand is geopend en de gebruiker gestart is met werken. Dit zorgt dat de gebruiker 
sneller aan de slag kan. 
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Navigeren tussen verschillende tabbladen  

De tabbladen zijn een essentieel onderdeel van de werkmethodiek. Ze stellen de gebruiker in staat om te schakelen tussen 
meerdere vensters, terwijl de maximale venstergrootte optimaal benut blijft. Vanaf ARCHICAD 23 wordt het switchen tussen de 
venstertabs makkelijker en sneller. Door met de cursor op de tab te gaan staan, zonder te klikken, wordt een preview van het 
venster getoond. Op deze manier kan eenvoudig het juiste venster worden geopend.

 
 
Gebruik de ‘Tab Overview’ (in de linker bovenhoek) om alle Previews naast elkaar te zien. Dit vergemakkelijkt de keuze voor het 
openen van verschillende vensters en zet snel diverse beelden naast elkaar. 

Let op! 
De preview toont de het venster met de status van de laatste keer dat het venster is geopend. Is een venster nog 
eerder geopend, dan staat er het symbool van het type venster.  

 

Sneller wisselen tussen vensters/tabs 
In ARCHICAD 23 wordt tijd die nodig is om te schakelen tussen de openstaande vensters/tabs verder gereduceerd. Door het 
inzetten van tijdelijk geheugen om inhoud van de vensters op te slaan wordt de tijd om te ‘Rebuilden’ aanzienlijk verkort. 
Dankzij deze optimalisatie voelt het schakelen intuïtiever.  

Sneller opbouwen van Views 

ARCHICAD verbetert continu de multi-core handelingen tijdens ingewikkelde rekenprocessen. In ARCHICAD 23 wordt ‘Multi-
Threading’ geïntroduceerd tijdens het ‘rebuilden’ van Views met eenvoudige elementen als: lijnen, cirkels, polylijnen etc.  
Dit is uitermate nuttig voor het werken met grote dxf/dwg-bestanden van bijvoorbeeld andere partijen of terreintekeningen.  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Alleen veranderingen ‘Rebuilden’ 

Wijzigingen in View-instellingen hebben vaak op een beperkt aantal elementen effect. ARCHICAD 23 identificeert alleen die 
elementen, waarop wijzigingen effect gaan hebben en zal alleen deze elementen ‘Rebuilden’. Hierdoor blijft het overgrote deel 
van de elementen ongemoeid, waarmee de ‘Rebuild-tijd’ significant wordt gereduceerd. 

Voorbeeld: 
Zo wordt het uitzetten van een ‘Layer’ bijna een directe handeling. Er wordt namelijk geen rekencapaciteit gebruikt, 
omdat er alleen minder elementen zullen worden getoond. Deze technologie wordt gebruikt in vele gebieden binnen 
ARCHICAD, waaronder het gebruik van ‘Trace and Reference’, zodat deze vensters praktisch direct geüpdatet zijn. 

Optie alleen zichtbare inhoud van Drawings op te slaan 

Wanneer een beperkt deel van een ‘Drawing’ zichtbaar is in een View of op een Layout, wordt de rest van de Drawing op de 
achtergrond gehouden. Als er veel van deze ‘cropped’ Drawings op een Layout staan zorgt dit voor een toename van de 
bestandsgrootte en een afname van de prestaties, tijdens het openen en (auto)saven.  
ARCHICAD 23 gaat optimaal om met deze ‘cropped Views/Drawings, door alleen het zichtbare deel op te slaan. Gebruikers 
kunnen nog kiezen tussen voor de oude methode waarbij de Drawings in hun geheel worden opgeslagen. Crops kunnen 
uiteraard later weer ongedaan gemaakt worden. 

Noot: 
Bij het schuiven van de inhoud van een cropped View/Drawing wordt gewoon automatisch de onzichtbare informatie 
getoond. 

 

Snellere IFC import en export 

Vanaf ARCHICAD 23 is het IFC import en export proces verder geoptimaliseerd: 
• MEP import is significant versneld 
• Grote IFC bestanden (>100 MB) worden nu een stuk sneller geopend of toegevoegd bij gebruik van een Model Filter bij de 

import.  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Interoperabiliteit 

Omdat GRAPHISOFT deel uitmaakt van de buildingSMART Implementation Support Group (ISG) wordt ervoor gezorgd dat de 
ontwikkelingen in ARCHICAD meegaan met de nieuwste technologieën, zodat gebruikers met andere disciplines of applicaties 
makkelijk samen kunnen werken. Dit hoofdstuk zal de focus op deze nieuwe features leggen. 

Volledige ondersteuning van IFC 4 

In ARCHICAD 23 wordt naast de IFC4 import nu ook de IFC4 Reference Model View export gecertificeerd ondersteund zoals 
door BuildingSmart gedefineerd en voorgeschreven. Dit is de laatste kwaliteitsstandaard voor open-source, IFC-gebaseerde 
uitwisseling. Daartoe ondersteunt de volledige interface van ARCHICAD de nieuw gepubliceerde entiteiten, eigenschappen en 
geometrische representaties van IFC4. 
GRAPHISOFT heeft alle tot nu toe beschikbare BuildingSMART IFC4-certificeringen behaald. 

Instellingen export/import van geografische referentiekaartgegevens 

Vanaf ARCHICAD 23 kunnen gebruikers geografische referentiekaartgegevens aan ARCHICAD projecten toekennen. Deze 
kunnen handmatig ingesteld worden in de Survey Point instellingen of met een IFC import. Deze GEO referentie gegevens 
kunnen samen met de andere locatiesgegevens uit ARCHICAD modellen met alle projectbetrokkenen gedeeld worden via IFC. 

Let op!  
• De eigenschappen ‘datum landmeting' en de ‘kaartprojectie'  moeten worden ingevuld. Deze data is een vereiste 

• Deze geografische referentiekaartgegevens worden alleen als eigenschappen (Properties) geëxporteerd naar IFC. 
Ze zullen niet de locatie van het model veranderen.  
• IFC 2x3: Informatie wordt geëxporteerd als twee nieuwe PropertySets  
• IFC4: Informatie wordt geëxporteerd als twee nieuwe IFC entiteiten: IFC Map Conversions en IFC Projected 

CRS.   

Elementen organiseren in IFC Building Systems 

Vanaf ARCHICAD 23 is het mogelijk ARCHICAD elementen te ordenen in ‘Building Systems’ (in het IFC Project Manager 
dialoogvenster). Een ‘Building System' is een groep waarin bouwelementen worden gegroepeerd volgens een 
gemeenschappelijke functie binnen het gebouw. 
De groep IfcBuilding System legt de aanwezigheid van een gespecialiseerd systeem voor het gebruik in de context van een 
bouw- en afwerkingsstructuur vast. Belangrijke functionaliteiten voor de beschrijving van een bouwsysteem zijn afgeleid van 
supertypes / predefined types. 

Voorbeeld: 
LOADBEARING Building System bevat alle bouwelementen die krachten overdragen en de constructie verstevigen. 
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Export van MEP-element aansluitpunten naar IFC (sinds AC22 5009 update) 

De import van MEP-element-poorten (verbindingspositie en gegevens) in IFC-bestanden was in ARCHICAD al mogelijk. Vanaf 
ARCHICAD 22 kunnen gebruikers deze elementen ook exporteren naar IFC-modellen. 

 

Brutogeometrie exporteren naar IFC 

Een nieuwe exportoptie (in de IFC Translator preset Geometry Conversion) maakt het mogelijk de brutogeometrie te exporteren. 
Als “Export gross geometry of elements" aangevinkt staat, worden elementen met deuren, ramen en/of openingen zonder 
gaten geëxporteerd. De openingen worden afzonderlijk geëxporteerd (IfcOpeningElement). Deze optie kan gebruikt worden 
voor een nauwkeurige kostenberekening uit een IFC model, waarbij de openingsgeometrie afzonderlijk beschouwd moet 
worden. 

Noot: 
Openingen worden geëxporteerd door IfcOpeningElement aan te vinken in de Model Filter for IFC-export. Dit staat in 

© KUBUS 12-11-2019  van  Handleiding ARCHICAD 2332 36



Informatie Management 

In vorige ARCHICAD versies was het al mogelijk om eigen Classificaties en eigen ARCHICAD Properties toe te kennen aan 
bepaalde gereedschappen of zones in een ARCHICAD model. 
Vanaf ARCHICAD 23 worden deze mogelijkheden verder uitgebreid voor Building Materials: het belangrijkste attribuut voor 
bouwcomponenten. 

Eigen Building Material Properties toevoegen 

Door de introductie van eigen ARCHICAD Classificaties en eigen gedefinieerde Building Material Properties, worden een aantal 
gebruikersproblemen opgelost voor het aanleveren van vereiste onderdelen. Met deze ontwikkeling kunnen gebruikers voldoen 
aan de eisen voor 4D/5D BIM software (kostenraming, kwaliteitsgaranties, model analyses) door middel van het toekennen van 
standaard of specifieke Classificaties en ARCHICAD Properties. Ook biedt deze mogelijkheid een robuust en betrouwbaar 
alternatief voor de huidige methode van de ingesloten Building Material data in het ‘Name’ veld en het uittrekken van eigen GDL 
scripts of IFC splitsing regels. 

De oplossing op Building-Material-niveau is vergelijkbaar met de elementniveau-oplossing, die geïntroduceerd werd in 
ARCHICAD 20. Hierbij kunnen de Classificaties en ARCHICAD Properties ingesteld worden bij respectievelijk de Classification 
Manager en de Property Manager. 
Zodra ARCHICAD Properties deel uitmaken van een Building Material, kunnen deze Building Material Properties uitgewisseld 
worden met andere projecten met behulp van XML bestanden (of direct) via de Attribute Manager. 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De Building Material Properties kunnen naar elke output geëxporteerd worden, zodat materiaal-gerelateerde BIM data op een 
coherente manier aangeleverd kan worden aan de betrokken partijen: 
• Building Material Properties kunnen gebruikt worden in de Interactive Schedule scheme settings als Criteria, maar ook als 

Field bij Component schedules. Zoals dit ook bij Element Properties mogelijk is.  

 

Tip: 
Bij de Fields van de Component Schedule kan er bij de Classificatie gewisseld worden tussen het weergeven van de 
Classificatie op elementniveau of op Building-Material-niveau.

  

• Building Material Classificaties en Properties zijn beschikbaar voor GDL-elementlabels (bijvoorbeeld ‘Label Classificatie en 
Properties’) voor alle uit het model afkomstige tekeningen. 

  
• IFC-export en -importmogelijkheden voor Building Material Properties. 
• Component Schedule data Fields kunnen geëxporteerd worden als ‘Component Properties’ in IFC2x3 formaat en als 

‘Material presets' in IFC4 formaat. 

Let op! 
- Elementen nemen geen Building Material Classificatie of Properties over in hun instellingen 
- Er kunnen geen Expressions gebruikt worden bij Building Material Properties 
- Ingevulde waarden bij Building Material Properties gaan niet mee bij export/import met Spreadsheets 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Bibliotheekverbeteringen 

Nieuwe vormen van intellectuele eigendomslicenties voor zelfgemaakte objecten 

ARCHICAD 23 introduceert drie nieuwe licentievormen voor eigengemaakte GDL objecten, oftewel Intellectual Property 
Licenses. Dit breidt de mogelijkheden uit voor het hergebruik en delen van eigengemaakte objecten als aanvulling op de 
bestaande licentievormen. 
 
Nieuwe licentietypen 
• Attribution 4.0  

Een object met deze licentie kan verder worden gedeeld (kopiëren en herdistribueren van het materiaal in iedere vorm of 
formaat) en aangepast (remix, transformeren en voortborduren op het materiaal voor ieder doel, inclusief commerciële 
doeleinden).  

• Attribution-ShareAlike 4.0 
Een object met deze licentie kan verder worden gedeeld (kopiëren en herdistribueren van het materiaal in iedere vorm of 
formaat) en aangepast (remix, transformeren en voortborduren op het materiaal voor ieder doel, inclusief commerciële 
doeleinden), maar het gewijzigde element moet gedeeld worden onder dezelfde licentie als het origineel. 

• Attribution-NoDerivatives 4.0 
Dit is een bijgewerkte versie van de licentievorm Attribution-NoDerivatives 3.0. Een element met deze licentie kan verder 
worden gedeeld (kopiëren en herdistribueren van het materiaal in iedere vorm of formaat), maar in aangepaste vorm mag 
het niet opnieuw worden gedeeld.  

Een licentie kan worden gekozen als een nieuw bibliotheek element wordt aangemaakt of als een bestaande wordt aangepast:

 
Los van deze uitgebreide licentievormen, worden alle ARCHICAD 23 standaard-bibliotheekobjecten en macros gedistribueerd 
met de licentievorm Attribution 4.0 (in tegenstelling tot de striktere Attribution 3.0 zoals in ARCHICAD 22 en eerder). Dit maakt 
het mogelijk voor iedereen in de ARCHICAD-gemeenschap om de bibliotheekobjecten en macros te hergebruiken en hiermee 
nieuwe objecten maken voor iedere doel, zelfs commerciële doeleinden. 

Algemene verbeteringen 

Verbeterde Curtain Wall raam 
Naar aanleiding van de ontwikkeling van de Curtain Wall in ARCHICAD 22, is er nu het ‘CW paneel louvre’. Hiermee kan binnen 
een veelvormige vliesgevel opening een ventilatierooster met louvres worden gemaakt. 

  

  
Het nieuwe Louvre type gebruikt de detailniveaus in de Model View Options Combinations > Detailniveau symbolen deur, raam 
en daklicht. 
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Verbeterd liftobject 
In ARCHICAD 23 is het liftobject verbeterd en uitgebreid met de volgende functies: 
• Keuze voor Building Materials 
• Betere interface om aan te geven hoe deuren worden weergegeven 
• Introductie van openingslijnen op de standaard manier zoals bij ramen en deuren 
• Nieuwe optie om de liftkooi te tonen in 3D en doorsnede 
• Pennen om beter de liftkooi, deuren en wand te onderscheiden 
• Verbeterd dialoogvenster om de verdiepingen in te stellen 

 
• Aanpassen van de afwijkende plaatsingshoogte van de deur per verdieping met hotspots 
• Verbeterde ‘Core Only’ weergave 
• Model View Options instellingen voor de weergave in 3D / doorsnedes en plattegrond 

 

Verbeterde hellingbaan-objecten 
Bij de hellingbaan-objecten (recht en gebogen) kan de hellingshoek op verschillende manieren op plattegrond/grondplan 
getoond worden. 

  
De hellingshoek kan onder en boven verschillen, ingevoerd in verhouding, percentage of hoek. 

© KUBUS 12-11-2019  van  Handleiding ARCHICAD 2336 36


